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Text to Speech 

 
 
 

Text to Speech (TTS) software speaks the text on the computer screen using a generated voice. 
TTS is one of the most powerful technologies for help with reading or writing. 

 
Many TTS tools can speak letters, words and/or sentences as you type them. These TTS 
programs use synthesized speech engines, some of the applications or programs have excellent 
human sounding speech engines.  
 
A text-to-speech (TTS) system converts normal language text into speech. 
 

 
 
 

 
  

https://en.wikipedia.org/wiki/File:TTS_System.svg
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Text to Speech – How to create MP3 files a Tutorial 

 
There have been many advances in computer technology and the area of text to speech is one 
of those areas. This short tutorial will show you how to convert text files into MP3 format files.  
 
This tutorial will cover the following topics: 
1. Text to Speech - Why do it? 
2. Software converter tools 
3. Text to Speech Advantages 
4. A Tutorial: Converting Texts into Audio (MP3 files) 
 
1. Text to Speech – Why do it? 

The followings are some reasons why people use Text to Speech: 
a. Give access to visually impaired. This is the main reason for developing text to speech 

technologies. 
b. Study Aid. If you need to read a book, you can get a text copy of it, convert it to an MP3 

file, and listen to it while driving, or taking a nap. 
c. Proof Reading. If you get a text to speech tool to read your copy back to you, often you 

will find more proof reading errors. Hearing the text is better than just looking at it. 
d. Presentation sound tracks. If you need to give a presentation you can write the text and 

create a video sound track. You will then be certain of how long the presentation will 
last and that it will be perfect every time. You can also distribute the presentation and 
do not have to be present for it to be played. 

 
2. Text to Speech – Software 

Some of the sites that you can visit to convert texts into audio are as follows: 
a. http://www.fromtexttospeech.com/ is a web site that you can use to play with small 

chunks of text. Paste the text into a text area. Submit the text, and an MP3 file of the 
text spoken by your selected voice will be returned. 

b. http://www.naturalreaders.com/ uses the same voices at the previous web site. 
However, this tool is not online. You need to download the software and install it on 
your computer. 

 
3. Text to Speech – Advantages 

Text to Speech offers some benefits, especially in learning a language. Some of the benefits 
are: 

a. Constant reading speed. There are four reading speeds you can use: slow, medium, fast 
and very fast. When people are nervous they tend to speed up and speak faster, the 

http://www.fromtexttospeech.com/
http://www.naturalreaders.com/
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computer is never nervous! In Text to Speech, you can adjust the reading speed you as 
you wish. 

b. No background noise. The readings will not have background noises to distract the 
listener. 

c. No accent problems. The computer-generated voice is clear and does not have a heavy 
accent. 

d. Correct Pronunciation of Words. Text to Speech helps you to pronounce words correctly 
as close as the natives. 

e. Constant volume. The volume of the voice is always constant no need to worry about 
continuity errors with microphone settings. 

f. Predictable reading times. With a constant reading speed, you will be able to accurately 
estimate how long a written text will take to present.  

 
 

 
 
 

5. A Tutorial: Converting Texts into Audio (MP3 files) 

Have you been stressful to find out appropriate audio listening 
materials for your students? 
Though there are abundant of materials available in internet, the topic 
or the materials are not contextual to your own lesson. 
This tutorial will help you creating audio listening materials based on 

your needs.  
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Steps 

 
1. Prepare a dialogue or a text based on the lesson/topic objective (you can either make or 

browse it from the internet, then adopt/adjust the content) 
e.g. In this tutorial, the selected topic is: At a Restaurant (Restaurant Dialogue) 

 

Sample Conversation 1 

 
Source: InterExchange Working Abroad, InterExchange, Inc., 2015 
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Sample Conversation 2 
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2. Open the link: http://www.fromtexttospeech.com/  

 
 
 

  

http://www.fromtexttospeech.com/
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Text to Speech Overview 

 
3. Copy the text which you want to convert into audio. You can either copy 

line by line, or directly copy the whole dialogue. 

Note: If you decided to copy the whole dialogue, make sure to enter () each line, and to 
use punctuation marks, either comma (,) or full stop (.) in order to have some pauses 
between the lines. 
Also, do not use name(s), only the expressions 

4. Make some selections: 
Select language: either US English or British English 
Select voice: either female (Alice, Daisy, Jenna) or male (George, Jone) 
Select speed: slow, medium, fast, very fast 

5. Click the “Create Audio File” Button 
6. Wait while the file is being processed. The estimated finish time is about 1 minute. 
7. Once the process is finished, the screen will show this: 

Box to place your 
text 

Language 
Selection: US 
English, British 
English, French, 
Spanish, German, 
Italian, 
Portuguese, 
Russian. 

Button to create 
the audio file 

Voice Selection: 
There are 5 
voice options (3 
females, 2 
males) 

Speed Selection: 
you can adjust 
the speed you 
need 
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To play the audio file, 
click this button 

To save the audio file, 
follow the instruction 
provided 
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Nowadays, there are many digital audio editors available that can do amazing things 

with sound. However, most of them cost money. Fortunately, there’s Audacity! 
Audacity is an open source cross platform audio editor you can download right away (follow the 
link to download (http://audacity.sourceforge.net/). It is simple and completely free. Besides, 
since it is open source, there are improvements being made to it on a fairly regular basis. For 
basic multitrack mixing for broadcast applications, you can do a surprising amount with it.  
This tutorial is intended to introduce you to Audacity, and will walk you through producing a 
very simple audio listening materials or test for language learning, especially English, composed 
of two sound files you will edit and eventually mix together.  
 
This tutorial will cover the following topics: 
 
Audacity – A Quick Overview  
Recording  

Basic Recording  
Listening to an existing track while recording a new one  

Exporting & Saving  
Exporting as .wav  

Exporting all tracks together (.wav)  
Exporting a single track, or a part of a track (.wav)  

Exporting as .mp3  
Exporting all tracks together (.mp3)  
Exporting a single track, or a part of a track (.mp3)  

Basic Editing  
Deleting audio  
The Edit Menu 
The Effect Menu 

Appendices 
Installing Audacity  
Downloading & Installing the MP3 encoder (lame.lib) 

Downloading the encoder 
Installing the MP3 encoder 
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Audacity Quick Reference 
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Audacity – A Quick Overview 
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Before You Record 
Setting Inputs and Adjusting Microphone Volume Levels 

1) Set your input to the correct 
microphone. 

a) On the Input/Output Toolbar 
select your microphone from 
the list. 

2) Test your microphone levels. 
a) From the Monitor Toolbar 

click the down arrow next to 

the microphone  to 
expand the menu. 

The Input/Output Toolbar 

 
The list of inputs will vary based on your 
soundcard. 

b) Select Monitor Input from the menu. 
c) Speak into the microphone. 

3) Use the microphone volume slider 

 to adjust the 
microphone level and avoid clipping 
(see Monitoring Microphone Levels, 
below)  

Monitor Input 

 
Selecting Monitor input allows you to 
adjust microphone levels before 
recording. 

Monitoring Microphone Levels 
Average - The brightest part of the bar 
shows the average audio level. 
 
Current Peak - The darker part of the bar 
shows the peak audio level. 
 
Recent Maximum (peak hold line) - The 
peak-hold line to the right of this shows the 
maximum audio level achieved in the last 3 
seconds. 
 
Clipping Indicators - The clipping indicators 
on the far right of each meter will light up if 
clipping is detected (meaning that the audio 
was too loud and will sound distorted). If 
clipping is detected when you are recording, 
you should stop, lower the volume of your 
input source, and start recording again from 
the start. 

The Monitor Toolbar 

 
Watch the monitor toolbar to avoid 
clipping 
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Recording 
Basic Recording 

 
Open Audacity 
 

1. Open Audacity (Double 
click on the icon on the 
desktop or click Start | 
Programs | Audacity) 

 
Adjust Volume Levels 
 
 

 
 
 
 
 

2. Test your microphone 
levels (optional). 

a. Press RECORD. 
b. Speak into the 

microphone 
c. If necessary, 

adjust the 
microphone 
volume. 

d. Press STOP when 
you have the 
correct levels. 

e. Delete your 
practice track 

 

3. Click RECORD. 
4. If you want to pause 

while recording click 
Pause. To continue 
recording on the same 
track, click PAUSE. 

5. When you are done 
recording, click STOP. 

 
The Basics – Recording and Playback 
Recording the Welcome Message 

1)  Click Record  
2) Record your welcome message. Here are a few examples for you to follow: 

Hi, I’m ___name___ and you’re listening to ___title___. 
It’s ___date___ and this is ___title___, your weekly exploration of ___subject___. 
It’s time for ___title___, ___subject___. 
Welcome to ___title___, a production of _department_. 
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3) Monitor your microphone levels. Be sure to avoid clipping (see monitoring microphone 
levels above). 

4) If you want to pause while recording click Pause  

5) When you are done recording, click Stop  
Listening to your Recording 

1) To listen to your recording, click Play 

 
2) To listen to a particular part of your 

recording: 

a) Choose the Selection Tool  (from 
the Main Toolbar).  

b) Click where you would like to begin 
listening. 

If you really don’t like it, delete it 

 
Deleting a track 

c) Click Play  
 
 
Listening to an existing track while recording a new one 

 
 
 

1. Open Audacity (Double 
click on the icon on the 
desktop or click Start | 
Programs | Audacity) 

 
 

 

2. Check the preferences to 
make sure Audacity can play 
and record at the same time. 
 a. Click on File and 
choose Preferences. 
 b. Click the Audio I/O 
tab. 
 c. Make sure that 
there is a check next to the 
box “Play other tracks while 
recording a new one.” 
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3.   Click File and choose Open 
4.    Browse to find your 
listening file and then click 
open. 
 
 
 
 
 

 

5.   Click RECORD to listen to 
the original track and record 
your own voice on a new 
track. 
 

 
 
Basic Editing 
Deleting audio 

1. Click and drag to 
select the audio that you 
want to delete. 
 
2. Press backspace or 
delete to delete this 
section of audio 
 
 

 

 
The Edit Menu 

the gray bar shows 
that this audio has 
been selected 
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1. Click and drag to select the 
audio that you want to modify. 
 
2. Select an option from the Edit 
menu. 
 
Edit Menu Options include: 
• Cut, Copy, and Paste 
• Trim (delete all audio except 

the selection) 
• Delete (the selected audio) 
• Silence (replace the selected 

audio with silence) 
• Duplicate (copy the selected 

audio to a new track) 
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Basic Editing 
Congratulations! You’ve recorded your welcome message! Now let’s do a little bit of 
editing. Most of the time, editing just means cutting out mistakes and quieting extraneous 
noises. Audacity gives you three ways to do this – deleting, silencing, and trimming. 
 
Deleting, Silencing, and Trimming (Keeping) 

1) Choose the Selection Tool    

2) Click Play  to listen to your recording. Listen for sections of audio that you would 
like to delete, as well any extraneous noises that you would like to delete or silence. 

3) When you find something that needs editing, click Stop  and note where the 
problematic audio begins. 

4) Click with the Selection Tool at the beginning of the problematic audio. Then click 
play again and find the end of the problematic audio. When you have a clear sense of 
where the edit should begin and end, follow the steps below. 

5) To delete a section of audio 
a) Click and Drag to select the 

audio you would like to delete. 
b) Press the Delete or Backspace 

key on your keyboard. 
6) To silence a section of audio 

a) Click and Drag to select the 
audio you would like to delete 

b) Click Silence  (on the Edit 
Toolbar). 

7) To trim (or keep) a section of 
audio, you select the audio that 
you want to keep.  

a) Click and Drag to select the 
audio you would like to keep. 

b) Click the Trim Tool  (on the 
Edit Toolbar). 

Selecting Audio 

 
The gray bar indicates the selected audio. 
Note – For Deleting and Silencing, you select 
the audio you don’t want. For Trimming, you 
select the audio you want to keep. 

 
Zooming in and Zooming Out 
Zooming in and out is very useful for editing audio. Sometimes you’ll need to zoom in to 
delete a very small segment of audio, other times you’ll want to zoom out to make 
changes to larger sections of your recording. Four buttons on the Edit Toolbar control 
zooming. 

 Zoom In   Zoom Out  Zoom to Selection (zooms in to a “close-up” of 
the selected audio) 

 Zoom to entire Project (zooms out to show you all of your work) 
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Importing audio and working with Multiple Tracks 
Importing your Theme Music 

1) From the Project menu, select 
Import Audio. 

2) Browse for the audio file you would 
like to import. (Note - Audacity 
imports WAV, AIFF, AU, MP3, and 
OGG formats.) 

3) Click Open. 

Import your theme music 

 
Use the project menu to import audio. 

A note about multiple tracks in Audacity 
When you import an audio file into Audacity, it is placed on a new track. In general, each 
part of your podcast will be a separate track within Audacity. This allows you to keep the 
various parts of your podcast organized. It also makes it easier to do common editing 
tasks. 

A Multi-Track Podcast recording 

 
This example of a completed podcast has four tracks, one for each part of the podcast 
(intro music, welcome, feature, and conclusion) 

 
Re-naming Tracks (optional) 

Working with multiple tracks can get confusing. 
To stay organized, you can change the name of 
each track. 

1) Click on the down arrow next to the current 
name of the track. 

2) In the dialog box, change the name of the 
track to something easily recognizable (e.g., 
intro music, welcome message, interview 
…) 

Re-naming a track 

 
Changing the name of a track to 
something easily recognizable is a 
good way to stay organized. 

 
The Time Shift Tool 
So far, you have your welcome message and your theme music in Audacity. At the 
moment, however, they both start at the beginning. Let’s move things around with the 
Time Shift Tool (the slider). 
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1) Click the Time Shift Tool  (from the Main 
Toolbar). 

2) Float your mouse over your welcome message. 
3) Click and drag to move the welcome message to the 

right of your theme music. Or, click and drag to 
move your theme music to the right of your 
welcome message. 

4) Click Play  to listen to your recording. 
 

 
 
 
 
 
 
 
Time-Shifting! 

 
Arranging tracks with the 
time-shift tool. 

Creating Simple Fades 
Audacity makes it easy to create fades, or gradual changes in the volume of a track. The 
Fade In effect makes a track start out quiet and gradually increase to full volume. The 
Fade Out effect does the opposite, gradually reducing the volume at the end of your track 
to silence. 

Fading In 
1) Select the audio at the start of your track. For a short 

fade, select a short segment of audio; for a longer 
fade, select a long segment of audio. 

2) From the Effect Menu, choose Fade In. 
Fading Out 

1) Select the audio at the end of your track. For a short 
fade, select a short segment of audio; for a longer 
fade, select a long segment of audio. 

2) From the Effect Menu, choose Fade Out. 

The Effect Menu 

 
Audacity makes fades easy. 

 
The Effect Menu 
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1. Click and drag to select the audio that 
you want to modify. 
 
2. Select an option from the Effect menu. 
 
Effect Menu Options include: 
• Amplify (increases or reduces the 

volume of selected audio) 
• Change speed (increases or reduces the 

length of time for selected audio) 
• Equalization (changes volume levels for 

low, mid, and high ranges of selected 
out) 

• Fade In/Out (gradually 
increases/reduces the volume level of 
selected audio) 
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Exporting & Saving 
When you finish working with your audacity tracks, you have several options for saving 
your files. You can save your files as an Audacity Project, or export them in .wav, .mp3, or 
.ogg formats. Here’s an overview of these options: 
 

File Format Audio Quality File Size Compatible 
with 

Best format for 

Audacity 
Project 

Excellent BIG! Only Audacity! 
Files you plan to 
continue editing 
in Audacity. 

.wav format Excellent BIG! 
Most media 
players 

Audio CDs, High 
Quality 
Recordings 

.mp3 Good Small 
Most media 
players 

Web audio 

.ogg Good Small Only Audacity 

Files you have 
finished editing, 
listen to only in 
Audacity 

 
Most of the time, you will save your files in .wav or .mp3 format. Audacity and .ogg 
formats are only good options if you are planning on doing further editing or if you know 
the files will only be used with Audacity. 
 
 
Exporting as .wav 
You can choose to export all of the tracks in your project, a single track, or any part of a 
track. 
Exporting all tracks together (.wav) 
If you have more than one track in your project this will “mix down” your tracks. In other 
words, the audio on each track will be combined, or mixed into a single track. 
 

 

1. Click File and choose Export as WAV 
 
2. Choose a destination and a name for your file. 
 
3. Click OK. 
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Exporting a single track, or a part of a track (.wav) 
Audacity allows you to export any part of a recording as a .wav file. This is useful if you 
want to break up a long recording into several smaller files. 
 

 

1. Select the part of the track that you want 
to export. If you are saving a single track, 
select the track that you want to save. 
 
 
 
 
 
 
 
 
 
 
 

 

2. Click File and choose Export Selection as 
WAV 
 
3. Choose a destination and a name for your 
file. 
 
4. Click OK. 
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Exporting as .mp3 
Exporting in .mp3 format is very similar to exporting in .wav format. You can choose to 
export all of the tracks in your project, a single track, or any part of a track. 
Exporting all tracks together (.mp3) 
If you have more than one track in your project this will “mix down” your tracks. In other 
words, the audio on each track will be combined, or mixed into a single track. 
 

 

1. Click File and choose Export as MP3 
 
2. Choose a destination and a name for your file. 
 
3. Click OK. 
 
 
 
 
 
 
 

 

4. For the format, we usually choose ID3v1 (more compatible). 
We have not had any problems with either format. 
 
5. Enter the recording information (optional). 
 
6. Click “OK” (note - You must click “OK.” In some versions of 
Audacity, clicking “Cancel” on this screen causes problems 
with the export). 
 
7. Close Audacity (you don’t need to save your audio in 
audacity format unless you want a high-quality back-up copy 
or need to do further editing). 
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Exporting a single track, or a part of a track (.mp3) 
Audacity allows you to export any part of a recording as an .mp3 file. This is useful if you 
want to break up a long recording into several smaller files. 
 

 

1. Select the part of the track that you want 
to export. If you are saving a single track, 
select the entire track that you want to 
save. 
 
 
 
 
 
 
 
 
 
 
 

 
 

2. Click File and choose Export Selection as 
MP3 
 
3. Choose a destination and a name for your 
file. 
 
4. Click OK. 
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5. For the format, we usually choose ID3v1 
(more compatible). We have not had any 
problems with either format. 
 
6. Enter the recording information 
(optional). 
 
7. Click “OK” (note - You must click “OK.” In 
some versions of Audacity, clicking “Cancel” 
on this screen causes problems with the 
export). 
 
8. Close Audacity (you don’t need to save 
your audio in audacity format unless you 
want a high-quality back-up copy or need to 
do further editing). 

Appendices 
A. Installing Audacity 
1. Go to http://audacity.sourceforge.net/ 
2. Click Download Audacity 
3. Click the link to download the most recent version 
4. After the download finishes, find the installer file and open it. 
5. Follow the installation instructions. 
6. You’re done! 
 
B. Downloading & Installing the MP3 encoder (lame.lib) 
Downloading the encoder 
In order to create .mp3 files with Audacity, you’ll need to download a special encoder 
called lame.lib. The encoder is a free file that allows audacity to create MP3s. 
for Windows 
1. Go to the LAME download page for Windows - http://mitiok.free.fr/  
2. Click on any link from the list of identical "lame-3.96.1" links. 
3. When you have finished downloading LAME, unzip it and save the file lame_enc.dll 

anywhere on your computer. It is a good idea to save it in the Audacity folder. Be sure 
to remember where you save the file. 

for Mac OS 9 or X 
1. Go to the LAME download page for Macintosh - http://spaghetticode.org/lame/  
2. Download the version of LameLib for your operating system. 
3. When you have finished downloading, use Stuffit Expander to extract the files. (This 

may happen automatically.) 
4. Save the file called "LameLib" anywhere on your computer. It is a good idea to install it 

in the Audacity folder. Be sure to remember where you save the file. 
Installing the MP3 encoder 
After downloading the encoder, install it by exporting any audio file as an MP3 in 
Audacity. You will only have to install the encoder once. 

 
Open Audacity 

1. Open Audacity ( Double click on the icon on the 
desktop or click Start | Programs | Audacity) 

http://audacity.sourceforge.net/
http://mitiok.free.fr/
http://spaghetticode.org/lame/
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2. Press “Record” and then “Stop” to record a little 
bit of audio. 

3. Click File and choose Export as MP3. 
4. Audacity will ask you to find the lame.lib encoder 

file. Browse to find this file on your hard drive 
and then click OK. 

 

5. Choose a destination and a name for your file. 
6. Enter the file information and then click OK. 
The MP3 encoder is now installed. You’re ready to 
export MP3 files! 
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Reference Links: 
1. https://iex-website2012.s3.amazonaws.com/files/working-abroad/pdfs/TE-

Intermediate_Lesson_Material-3.pdf 
2. https://www.phrasemix.com/collections/english-expressions-that-waiters-waitresses-

and-restaurant-s 
3. http://tx.english-ch.com/teacher/cristina/level-a/dialogue-ordering-in-a-restaurant/ 
4. http://drewseslfluencylessons.com/2-advanced/restaurant/english-script-for-

restaurant-vocabulary-conversation-activity/ 
https://www.youtube.com/watch?v=TkRxXSO36ME 

5. lss.wisc.edu/sites/default/files/audacity_guide_3_05.doc 
6. lss.wisc.edu/sites/default/files/audacity_podcasting_tutorial.doc 
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VIVA VIDEO – Create your video story 
 

This tutorial will cover these following topics: 
 
1. Using video for language learning  
2. Key advantages of using video lectures  
3. Viva Video – What is it? And Why do we use it? 
4. Creating and editing video using VivaVideo 

 
 
The reasons to use video for language learning 
 
As an English teacher, why do we need to use videos in the ELT classroom? Lansford (2014) 
mentions six reasons why we should be using video in the ELT classroom; these six reasons 
are: 
 
1. Video speaks to Generation V 

Since the release of Skype in 2003 and YouTube in 2005, internet usage has increased 
from 16% of the world’s population in 2005 to about 40% in 2014. Nowadays, it reaches 
49.6% according to the Internet World Stats (2017). Kids nowadays communicate 
routinely via video chat, and they are exposed to many social media available now. 
 
According to Lansford (2014), “for Generation V (the V stands for ‘video’, in case you 
hadn’t guessed), video isn’t just a passive form of entertainment, it’s also the mode of 
delivery for interactive communication, and for information accessed on a daily basis. 
Our students are accustomed to using video, and we teachers can use that to our 
advantage.”  

 
2. Video brings the outside world into the classroom 

Because of the widespread use of the internet, we now have wide access to videos such 
as newscasts, advertisements, comedy, documentaries, dramas, even academic lectures 
and student-produced projects. Not all of them might intentionally be produced as 
teaching materials; thus, they serve as authentic materials. They can then be one of the 
best materials for language learning once they are adapted to be pedagogically 
appropriate. For example, we can use cooking tutorial video from YouTube to teach 
procedure text.   
 

3. Video engages learners 
Video is not only an entertainment for learners, but also a source of information. We 
can create a lesson around it that helps learners develop their language skills, and at the 
same time capture and hold their attention. When we use video, the lesson will be 
effective, and enjoyable.   
 
 

4. Video is a great source of information  
Video can be excellent sources of information since the visual input often helps clarify 
and support the language input.  
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5. Video provides stimulus for classroom activities 

Academic skills such as summarizing, paraphrasing, and giving an opinion are often 
linked with reading as a source of input. We can actually use video as an information-
rich ‘text’ that can provide students with the ideas and concepts that they must learn to 
manipulate successfully.  
  
Video can also provide a good reference point for critical thinking: for example, in 
considering advertisements, learners can develop the skills of considering motivation, 
whether or not supporting details are valid, and so on. 
 

6. Video provides a good model for learner output 
We can use video as a language input, and then use it also as a model for learners’ 
output. For example, when we teach student public speaking skills, we expose them to 
speech videos and then instruct them to create one with the videos as the models.    
 

Key advantages of video lectures 
 
1. Easy to access anytime  students can learn anywhere, anytime, from their mobile 

devices such as smartphone, tablets, and laptops.   
2. Learn whenever you want  let students enjoy the process of learning whenever they 

want. 
3. Learning at an individual pace  every student has his or her own pace of learning. With 

video lectures, they can learn at their own individual pace, which will maximize the 
results of e-learning. 

4. Many ways to use  videos can be used for distance learning as well as for in-class 
activities. 

5. Easy to deliver  teachers can provide students with unlimited access to their materials 
by uploading video lectures to the Web or LMS. 

6. More effective learning  students will not miss anything even when they did not 
attend the class since they can keep up with the lesson by watching to the video 
lectures.  

7. Opportunity for self-study  teachers can add useful materials and resources for 
students self-study in the video.  

8. Chance for self-testing  teachers can watch their own videos to reflect to the way they 
teach. 
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VivaVideo – What is it? And Why do we use it? 
 
VivaVideo is a very popular video editing app developed by QuVideo Inc. It is by far one of 
the best video camera & video editor apps in mobile app market with more than 380 million 
users all over the world. It is even ranked as No. 1 free video editor & video maker app in 
more than 100 countries. What makes VivaVIdeo so special that it has so many users all 
over the world? 
 
1. It is free (except for the VIP account). 
2. It is available for both iOS and Android users.  
3. It is a user-friendly app - simple 
4. It has some cool key features – professional: 

a. Professional video editor & photo video maker – trim/merge/cut/loop/copy/fast 
& slow motion 

b. 1000+ FREE creative video effects & music – video theme/animated 
stickers/filters/transitions/GIFs/texts/subtitles 

c. HD camera with different video lens – basic/music video/collage/selfie/facial 
effects 

d. Powerful video player and converter – safely play videos and convert format of 
videos/GIFs 

 
 
Creating and editing video using VivaVideo 
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Have you used videos for your classroom activities especially 
listening activities?  
Do you usually create one or find videos online which are 
best suit your need?  
If you usually find videos online, have you been stressful to 

find appropriate videos for your listening activities? 
 
Even though there are a large amount of videos available online in the internet nowadays, 
the topic or the materials, sometimes, are not contextual to your lesson. Therefore, it will 
be helpful if we can create our own videos.  
 
Let’s do it! 
 

Steps 
 
1. Prepare your mobile devices (smartphone or tablets). If you haven’t had the app on your 

mobile devices, please first download the app from Play Store for Android phones and 
App Store for iOS phones. 
Note: you can use ‘Workshop on ICT’ Wi-Fi with the password: easy 
 

2. After you downloaded the app, then open it. The first time you open it the interface will 
be like this. You can just click the x and ignore it. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Prepare a dialogue or a script based on the lesson/topic objective (you can either make 

or browse it from the internet, then adopt/adjust the content) 
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e.g. In this tutorial, the selected topic is: At a Restaurant (Restaurant Dialogue)  we 
use the same topic and the same dialogue with the previous one (sample conversation 
1) 
 

4. Watch the example video. 
 

5. Create your own video in pairs.  
 
6. Edit the video. 
 
 
 
 
Reference links: 
1. http://www.cambridge.org/elt/blog/2014/03/27/six-reasons-use-video-elt-classroom/ 
2. https://www.internetworldstats.com/emarketing.htm 
3. http://www.ispringsolutions.com/articles/key-advantages-of-video-lectures.html 
4. https://www.britishcouncil.org/voices-magazine/how-can-film-help-you-teach-or-learn-

english 
5. http://vivavideo.tv/en/index.html 
6. http://hybrid.xiaoying.tv/web/vivaVideo/index/Tutorial.html 
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Turn Online Videos into lesson with EDpuzzle 
 

 
Who? 

Edpuzzle can be used by all educators. Creating an account and 

editing a video is very easy using this online tool. Videos are available 

online, but teachers can also upload their own videos. Videos can be 

taken from YouTube, Khan Academy, National Geographic, TED 

Talks, and many more.  

 

What? 

EDpuzzle is an innovative site that lets teachers take any video from the web, edit it to meet 

their needs by trimming the video and adding audio notes and questions for students, and 

create virtual classrooms where they can monitor individual student work. Yes, what makes 

this tool even more excellent is that teachers can prevent students from skipping the video, 

and teachers will get the report on how well the students do the task.  

 

Why? 

By using EDpuzzle, learning can be more interesting and exciting for the students. It does 

not only provide a flipped classroom assignment, but also add interactivity to an at home 

lesson.  

 

 
 
 
 
Let’s try! 

 

Steps 
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1. Create an account at edpuzzle.com  for ease of remembering, use a Google account if 

you have one and save yourself an extra password! 

 

2. After you create an account, click create to create an educational video. 

Once you click create, you will be in this page: 

  
 

3. Choose a video or concept you would like to make a video about. You can actually 

choose to upload your own video, but for this workshop let’s use a video from one of 

the sites listed on the left margin of the page.  

 

4. Make at least one crop to your video  this can be at the beginning or at the end of the 

video (or both) as you see fit. 

 

5. Add at least two audio notes to your video.  

 

6. Add at least three questions to your video. 

 

Reference links: 

1. http://www.edudemic.com/edpuzzle-review-easy-use-tool-lets-teachers-quickly-turn-

online-video-lessons/ 

2. http://larryferlazzo.edublogs.org/2013/11/03/edpuzzle-is-an-innovative-video-site/ 

3. http://edpuzzlejhu.weebly.com/ 
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